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1. Introduction 

 
Thank you for your interest in the ASN Filter Designer. This product is available in two flavours, as summarised 
below:  
 

 Professional Lite 

Maximum IIR filter order: 4 4 

Maximum FIR filter order: 248 64 

Maximum Frequency: 1 GHz 10KHz 

Maximum zoom depth: 15 5 

Licence: Commercial use Evaluation/non-commercial use 

Price: €125 + VAT Free 

 
Please contact us at support@advsolned.com if you would like to buy a licence for the professional edition. We 
also offer academic and group licensing discounts, so please ask! 

 
 

1.1. Getting started 

 
The ASN filter designer has been designed around Microsoft's .NET technology, and as such requires .NET 

framework 4 to be installed before installation of the ASN Filter designer can continue. Where, the currently 

supported operating systems are: Windows 7, Windows 7 Service Pack 1, Windows Server 2003 Service Pack 2, 

Windows Server 2008, Windows Server 2008 R2, Windows Server 2008 R2 SP1, Windows Vista Service Pack 1, 

Windows XP Service Pack 3.  

After downloading the '.zip' archive from ASN's website, please double click on 'setup.exe' in order begin the 

installation procedure.  

 

 

 
Setup.exe will automatically check to see if .NET framework 4 needs to be downloaded, and will then continue 

with the installation. It is important that the latest updates to the .NET framework 4 are installed, so please run 

Windows update after the install wizard has completed. 
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1.2. Types of Filters 
 

The ASN Filter designer implements both IIR (infinite impulse response) and FIR (finite impulse response) type 

filters. Unlike other filter design packages, the ASN Filter Designer aims to simplify the task of digital filter design 

by limiting the number of options to the bare essential.  

 

A common problem experienced by many engineers is, "what parameters do I need to enter ?"  

 

Although the cut-off frequency, sampling frequency and the type of filter may be clear, extra details, such as 

passband ripple, stopband attenuation, filter order require much more understanding. We hope that the ASN 

Filter Designer's simplified GUI addresses these issues, by providing users with a simple and intuitive design tool. 

1.2.1. IIR Filters 

 

All IIR filters are implemented as biquad filters (i.e. two poles and two zeros), where you may choose either a 

2nd or 4th order implementation. The biquad implementation is particularly useful for fixed point 

implementations, as the effects of quantization and numerical stability are of no great concern. However, the 

overall success of any biquad implementation is dependent upon the available number precision, which must be 

sufficient enough in order to ensure that the quantized poles are always inside the unit circle.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Analysing Figure 1, it can be seen that the biquad structure is comprised of two feedback paths (scaled by 1a  

and 2a ) and two feed forward paths (scaled by 1b and 2b ). The filtering operation of Figure 1 can be summarized 

by the following set of recursive equations: 

 

)2()1()()( 21  ndandanxnd  (1) 

)2()1()()( 210  ndbndbndbny  (2) 

 

Figure 1 – Direct form II (biquad) IIR filter realization. 
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Analyzing Eqns. (1) and (2) notice that the biquad implementation only requires four additions and five 

multiplications, which can be easily accommodated on any modern micro-controller/DSP. Also, implementing  

the direct form realization into two steps, i.e.,  Eqns. (1) and (2) significantly reduces the filter’s sensitivity to 

quantization error. Please visit our website for more details about fixed point filter implementation.  

 

The following analogue prototypes (transformed using the Bilinear transform) are available:  

 Butterworth 

 Chebyshev Type I (passband ripple 0.1dB) 

 Chebyshev Type II 

 Elliptic  (passband ripple 0.1dB) 

 

You may choose a stopband attenuation of either 20 or 40dB.  

 

1.2.1.1. Sine/Cosine Oscillators 

 

The GUI facilitates the design and analysis of simple sine and cosine oscillators by virtue of placing a conjugate  

pole pair directly onto the unit circle. You may choose either a Sine or Cosine waveform from the Type menu, as 

shown below: 

 

 
 

The GUI will automatically set the filter order to 2. 

 

Care should be exercised when performing analysis on the phase delay and group delay plots when using 

double precision, as the extra detail may (in some case) result in misleading results.  We therefore advocate 

using single precision for floating point analysis.  
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1.2.2. FIR Filters 

 

FIR (finite impulse response) filters are useful for a variety of signal processing applications, including audio 

signal processing and noise cancellation. Although several practical implementations for FIRs exist, the direct 

form I structure is perhaps the most commonly used, and as such all designed filter coefficients are intended for 

implementation in a Direct form I structure.  
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All standard FIR filters (lowpass, highpass, bandpass and bandstop) are designed based on the Window method. 

However, the Multiband filters are based on the frequency sampling method. The following window functions 

are available: 

 

 Blackman 

 Blackman Harris 

 Hamming  

 Hanning 

 Chebyshev 

 FlatTop 

 Gaussian (= 2.5) 

 Lanczos 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2 – Direct form I FIR filter realization. 
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A filter order of up to 248 may be implemented in 

the professional edition, whereas this is limited to 

64 in the Lite edition. 
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2. The GUI 
 

The ASN Filter designer can design both IIR and FIR filters, and as seen below has very simple to use user 

interface. At start-up, a default 4th order IIR Butterworth filter is designed and its frequency response plotted.   

 

 
 

Figure 3 - The default GUI. 

 

The GUI automatically checks for invalid entries as the user types, and as such a green check mark  is shown 

for a valid entry or alternatively red cross  is shown for any invalid entries. Pressing on the Design button 

will design the filter for the entered specifications. 
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2.1. Valid Frequencies 
 
The professional edition of the product allows you to enter sampling frequencies from 1Hz to up to 1GHz -  

whereas, the Lite version is limited to a maximum frequency of 10KHz. As seen above, three frequency ranges 

are available: Hz, KHz and MHz. You may enter a sampling frequency in the range 1-1000, including fractional 

sampling frequencies up to 3 decimal places. As an example, a sampling frequency of 1248Hz, should be entered 

as:   

 

 
 

In all cases, the program will validate the user input and in the event of an invalid entry, a pop up text box will 

provide hints and tips. 

 

2.1.1. Cut-off Frequencies/Stop band frequencies 

 
All cut-off frequencies as standard should be entered in ascending frequency pairs, i.e. start frequency and stop 

frequency. Where, the two frequencies must be delimitated (separated) by a  ',' or ';'. For example:  100,250 

and/or 100;250  are valid entries, whereas: 100 250 or 250,100 are not.  

 

 

 Example: Speech filter 

 

Fs = 8KHz 

Lower frequency = 300Hz 

Upper frequency = 3.3KHz 

 

 
NB. Multiple cut-off frequencies used in Multiband filters require at least two pairs of cut-off frequencies. 

However, it is important to realize that  lowpass and highpass filters only require one cut-off frequency, and as 

such are a special case of the standard rule.  
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2.2. Data analysis 
 
Data analysis is performed with the mouse. Where, moving the mouse over the graph will automatically 

produce the data cursor and the data point's details, as seen below: 

 

 
 
you may swap between the Magnitude spectrum, phase spectrum, Group delay, phase delay, Impulse response 

or step response via the Analysis menu. 

 

 

 The current plot may be copied to the clipboard by 

selecting the Copy to Clipboard option. The 

resulting image may then be pasted into a third party 

application. 

 

Data cursor 
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2.3. Advanced frequency zoom 
 
The GUI implements an advanced frequency zoom feature by virtue of a specialized implementation of the DFT 

(discrete Fourier transform).  This allows for detailed frequency analysis with very little computational power, 

resulting a fast responsive GUI. 

 

Frequency Range Maximum Zoom Resolution 

MHz 1KHz 

KHz 1Hz 

Hz 10mHz 

 
Table 1 - Maximum zoom resolutions. 

 
The advanced zoom feature allows users to quickly and simply obtain detailed frequency response information 

even when the sampling frequency is several hundred MHz (professional edition only)! 

 

2.3.1. Zooming In 

 

De-pressing the left mouse button on the plot and dragging the mouse either left or right will highlight the 

region to be zoomed and also produce a zoom summary box, as shown below: 

 

Region to be zoomed 

Summary of zoom. Where, the 

maximum zoom resolution is 

given in Table 1. 

.  
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2.3.2. Zooming out 

 
Right clicking on the plot will produce a zoom menu. A check mark indentifies the current level of zoom and 

resolution. A maximum of fifteen levels of zoom can be accommodated for  professional edition, whereas only 

five levels can be accommodated for the Lite edition. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Zoom menu 

Current zoom 
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2.4. Multiband Filters 
 
In order to implement an arbitrary frequency response, you may use either the Multiband or Inverse 

multiband filter. The Multiband filter begins with an all stop frequency response whereas the Inverse 

Multiband filter begins with an all-pass frequency response. You may enter up to a maximum of five pairs of 

start and stop frequencies. 

 

The example shown below demonstrates two pairs of start and stop frequencies with a Blackman Harris 

window for a 248th order FIR filter (double precision arithmetic). 

 

 
 
 
 
 
 
 
 
 
 

Minimum 
stopband gain 

-6dB or -3dB  
(IIR filters) 
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2.5. The File Menu 
 
All file related commands, such as export, printing, opening and saving the project are available via the File 

menu. 

2.5.1. Exporting Data 

 
You may export all plot data (at the current level of frequency domain zoom) to an ASCII text file via the Export 

to File -> All plots menu option. Please note, that all 250 points of time domain data are exported 

regardless of the time domain zoom. 

You may also export the filter summary and coefficients to a ASCII text file or a SensorPro1 filter configuration 

file via the Filter Coefficients sub menu option. 

 

 

2.6. The Filter Menu 
 
All filter related operations, such as Arithmetic/quantization used in the computation may be accessed via the 
Filter menu. 
 

2.6.1. Filter Arithmetic 

 
The ASN filter designer allows you to quickly and easily analyse the effects of quantization on the designed filter 

via  the Arithmetic menu option.  

 

By default, 'Double precision' arithmetic is used for the calculation of all 

filter coefficients and their subsequent impulse and step responses. 

However, you may perform fixed point analysis by selecting Fixed Point 

from the Arithmetic  menu (see left) and choosing the required Word 

Length and Fraction length that you require. All plots will display the 

results based on the quantization/Arithmetic settings. 

 The Smart Scaling option is designed for IIR design in order to 

ensure that no internal overflow occurs in the designed Biquads and that 

all filter coefficients can be correctly represented. This is especially useful 

for cases when there is no integer component, e.g. Q15 (16 bit word 

length and a fraction length of 15 bits). You may enable or disable Smart Scaling via the check box (see left) 

if you wish to assess the performance of your filter without any scaling. 

 

2.6.2. View current filter summary and filter coefficients 

 
A summary of the designed filter is always available via the View Current Summary menu option. This 

function is handy in situations where the GUI parameters have been altered after designing a filter, and the user 

has forgotten what settings were used for the designed filter. 

                                                 
1
 SensorPro is Advanced Solutions Nederland's advanced real-time data acquisition and analysis module. Please contact us for more 

information. 
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The filter summary also displays results of the quantization procedure. If Fixed Point arithmetic is 

selected the resulting filter summary will display both the quantized filtered coefficients in float and Hex format, 

as shown below. The Hex format coefficients may be directly implemented in any DSP/micro-controller. 

 

 
 
 
 

Document Revision Status 
 

Rev. Description Date 

1 Document released. 17/11/2011 

2 Document updated for oscillators 12/12/2011 

 
 

Fixed point filter coefficients 
(float format) 

Fixed point filter coefficients 
(Hex format) 
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